A User’s Guide to

GARRITAN HARPS

Including the ARIA™ Player

Copyright © 2012 by MakeMusic Inc. All rights reserved.

This guide written by: Gary Garritan

Produced by: Gary Garritan
Programming: Chad Beckwith, Robert Davis
ARIA Engine Development: Plogue Art et Technologie, Inc.
Document Editing: Jonathan Tschiggfrie, Erin Vork
Art Direction and Graphics: Scott Menk
Project Management: Chris Anderson, Justin Phillips

Garritan Harps™ is a trademark of MakeMusic, Inc. Use of the Garritan Harps library and the contents herein are subject to the terms and conditions of the license agreement distributed with the library. You should carefully read the license agreement before using this product. The sounds presented in Garritan Harps are protected by copyright and may not be distributed, whether modified or unmodified. ARIA is a trademark of MakeMusic and Plogue Art et Technologie Inc., Finale® is a trademark of MakeMusic, Inc., EndlessWave™ is a trademark of Conexant, Inc., and any other trademarks of third-party programs are trademarks of their respective owners. No part of this publication may be copied, reproduced or otherwise transmitted or recorded, for any purpose, without prior written permission MakeMusic, Inc. The information contained herein may change without notice and does not represent a commitment on the part of MakeMusic, Inc.

GARRITAN HARPS
MakeMusic, Inc.
Eden Prairie, MN 55344-3848

Visit us online at: www.garritan.com
CONTENTS

Credits ............................................................................................................................................ 2
Table of Contents .......................................................................................................................... 4
Welcome to Garritan Harps.......................................................................................................... 6
Garritan Harps at a Glance ........................................................................................................ 7
End User License Agreement ..................................................................................................... 9
What the Garritan Harps Package Includes ............................................................................. 11
Computer System Requirements ............................................................................................... 12
Regarding Sound Cards, Audio, and MIDI .................................................................................... 14
Regarding Speakers, Amplification, and Headphones ................................................................. 15
Regarding 64-bit Computing ...................................................................................................... 15

INSTALLATION & ACTIVATION ................................................................................................... 16
Installation .................................................................................................................................... 17
Activation ...................................................................................................................................... 19

ARIA PLAYER BASICS ................................................................................................................. 21
Navigating the ARIA Player Interface ......................................................................................... 22
Using the ARIA Player .................................................................................................................. 24

ABOUT THE HARP ........................................................................................................................ 26
A Brief Overview of the Harp ....................................................................................................... 27
Notating for Harp .......................................................................................................................... 34
A Brief History of the Harp ........................................................................................................... 35

PLAYING GARRITAN HARPS ....................................................................................................... 48
Loading Instruments ..................................................................................................................... 49
Making Sounds .............................................................................................................................. 51
Controls ....................................................................................................................................... 55
MIDI Controller Quick Reference .............................................................................................. 59
Effects .......................................................................................................................................... 60
WELCOME
TO GARRITAN HARPS

The harp is known as the instrument of heaven and angels and deservedly so. It is as perfect an instrument as there is on this earth. It is one of the oldest instruments dating back to antiquity.

The harp holds a special place in my heart. From early childhood I wanted to play the harp after seeing Harpo Marx play in a movie. When a harp teacher moved to the area, I had the opportunity to begin lessons and thus my love affair with the instrument grew every day.

It was while developing an electronic MIDI harp that I first became acquainted with the world of sampling. In need of quality harp samples for my performing, I developed the GigaHarp, one of the very first independent and detailed libraries for the then-groundbreaking Gigasampler. The ability of Gigasampler to stream gigabytes of samples and play multiple dynamic levels in real time was a revolution. Nothing like it had been done before. The GigaHarp set the standard for quality, expression, and performance—not only for harps, but for all other sample libraries. The GigaHarp was an unqualified success and thus began my start as a sample developer. So the harp has been with me all along in my musical journey.

Why has the harp lasted for thousands of years? There is something about the sound of the harp that relaxes people. The soothing sounds of the harp have calmed the most agitated spirits from the days of old. The harp has also been acknowledged as a healing instrument by many cultures throughout history and there is now research that proves its healing effects. Patients undergoing harp therapy attest to increased relaxation, better sleep, decreased pain and anxiety, and mood improvement. No other instrument makes a positive impact quite like the harp. Harps are also beautiful to look at and evoke a sense of awe and enchantment even when not being played.

Fast forward to today: much has happened with music technology since the original GigaHarp. We can do so much more now. Because the harp is my favorite instrument, I had wanted to revisit and improve upon a harp library with the latest technologies. And since developing the GigaHarp we have acquired the entire Gigasampler/GigaStudio technology.

Yours in music,

Mary Manion
GARRITAN HARPS AT A GLANCE

Thank you for choosing Garritan Harps. The following summary presents some of the outstanding features of Garritan Harps:

First and foremost, the pure and pristine sound of the harp — The harp featured in Garritan Harps is one of a kind and unique. Each string of two Salvi pedal harps was recorded separately with a piezoelectric sensor (RMC Pickup Co.) on each string. Each string was sampled for the entire life of its natural decay. The sound of each string is sweet, pure, powerful, and dynamic, with minimum crosstalk. Likewise, every individual strings was sampled on two Venus Concert Grand harps and a Lyon & Healy harp. Each harp was sampled in a different recording space, offering a nice variation in perspectives that offers the best of all worlds.

Full-Ranged Harp Articulations — There are traditional angelic-sounding harp plucks (gentle, soft plucks, medium plucks, and loud plucks) as well as harmonics, Près de la table (played near the soundboard), picked, dampened, and other types of playing techniques.

Glisses, Glisses, and More Heavenly Glisses — Glissandi, or glisses, are the hallmark sound of the harp. Glisses on a harp sound heavenly. Using the unique built-in keymapping to emulate the pedals of a harp, you can easily play realistic harp glissandi and arpeggios that can be customized to your music (rather than time-stretching or pitch-shifting harp glissando samples). They are played in Garritan Harps by running one’s fingers up and down the keyboard.

Easy to Play and Control — Create your heavenly harp music quickly and easily. Just load your harp and play. With Garritan Harps’ standardized controls, you will become familiar with the library quickly. Users can also choose and adjust the harps’ acoustic environments.

Sample Player with Disc Streaming Included — The entire Garritan Harps collection is integrated into the ARIA Player and works as a software musical instrument. There is no need to purchase a separate sampler. Garritan Harps also features the Conexant® EndlessWave™ technology for hard disc streaming of multiple harps and techniques.
**Universal Format** — You can play great-sounding harp music as a standalone application, as a plug-in with your sequencer, or directly from the score within your notation program. Garritan Harps supports all popular plug-in formats (VST, Audio Units, and Pro Tools RTAS) on both Mac and Windows.

**Suited for Every Musician** — This collection brings the glorious and soothing sounds of the harp into your studio, place of worship, rehearsal room, or home at a fraction of the cost and takes up far less room. Composers can use this collection for inspiration to capture creative ideas and sketch harp arrangements quickly. Hobbyists can use it for adding harp sounds to their tracks. Beginners, harp enthusiasts, and music students can use it to learn and study harp music at home. The harps in this collection can also be used to supplement Garritan Personal Orchestra and other sample libraries.
END USER LICENSE AGREEMENT

Please read the terms of the following software licensing agreement before using this software. By installing and loading these products on your computer you acknowledge that you have read this license agreement, understand the agreement, and agree to its terms and conditions. If you do not agree to these terms and conditions, do not install or use the sounds contained herein. This is the complete agreement between you and MakeMusic, Inc., that supersedes any other representations or prior agreements, whether oral or in writing.

An important thing to understand is that YOU ARE OBTAINING A LICENSE FOR YOUR USE ONLY—THE SOUNDS DO NOT BELONG TO YOU. The implications are described below. The sounds, samples, and programming in Garritan Harps™ remain the sole property of MakeMusic, Inc., and are licensed (not sold) to you. There will be no refunds once installed and registered.

WHAT YOU MAY DO: You may use these sounds in recordings, music productions, public performances, and for other reasonable musical purposes within musical compositions. You may use these sounds in your own musical compositions as much as you like without any further payment to MakeMusic, Inc., or need to obtain further permission. If you do use these sounds, we ask that you include the following credits referencing the sound library used in any written materials or credits accompanying your music that utilizes material from Garritan Harps (CD booklet, film credits, etc.): “Instrument samples used in this recording are from Garritan Harps”—or a similar credit where practicable. You are allowed a maximum of four (4) installations per purchase.

WHAT YOU MAY NOT DO: The enclosed sounds may not be re-used in any commercial sample library or competitive product. You are absolutely forbidden to duplicate, copy, distribute, transfer, upload, download, trade, or loan this software or any of the contents in any way to anyone. You may not redistribute this product in whole or in part through an archive, collection, through the Internet, or a binaries group, newsgroup, or any type of removable media, or through a network. You may not resell the product without written permission and payment of an additional fee. The sounds and samples contained within this software may not be edited, modified, digitally altered, re-synthesized, or manipulated without direct written consent from MakeMusic, Inc.

DISCLAIMERS AND CONDITIONS: The right to use Garritan Harps is granted to the original end-user only, and this license is not transferable unless there is written consent from MakeMusic, Inc. and payment of an additional fee. The sounds from Garritan Harps will only work with the bundled Garritan ARIA Player and will not work with any other sampler. Licensor will not be responsible if the content of this product does not fit the particular purpose of the Licensee. Please make sure before installing this item that it meets your needs, as there are no refunds. Information contained herein is subject to change without notice and does not represent a commitment on the part of MakeMusic, Inc. The sounds are licensed “as is” without warranties of any kind. Neither MakeMusic, Inc., nor any agent or distributor, can be held responsible for any direct or indirect or consequential loss arising from the use of this product in whatever form. The ARIA Player is covered by the installer’s End User License Agreement and is incorporated by reference. The terms of this license shall be construed in accordance with the laws of the United States of America and the State of Minnesota. The user agrees to read the manual before seeking technical support and to make sure his or her system meets or exceeds the recommended requirements. Garritan Harps may not be returned for any reason other than manufacturing defects.
“The harp is to music ... what music is to life.”
—Carlos Salzedo (1885-1961)
WHAT THE GARRITAN HARPS PACKAGE INCLUDES

This Garritan Harps library includes the following:

The “Garritan ARIA Player” installer file that contains the ARIA Player software and the ARIA User's Manual in PDF form.

The “Garritan Harps” installer file that contains the Garritan Harps sample library and Garritan Harps User’s Guide in PDF form.

If you have not received an activation key card by e-mail, a unique serial number is provided so that you can register the product and receive a key card. Don't lose this—store it in a safe place! You may have received this serial number through a reseller if you purchased a download version from them.

**NOTE:**

Make sure to get the latest ARIA Player update. Periodic updates are always being made. Log in to your account at www.garritan.com/support to get the very latest.

Before you begin the installation, make sure you have read the End User License Agreement on page 9. By installing the software, you are indicating that you agree to the terms of the license.

“GLISS OVER” THIS MANUAL

The goal of this manual is to help you learn how to use the instruments of Garritan Harps and how to use the controls to play the instruments. Although many dislike reading manuals, if you wish to get the most out of this new library it is essential to read this manual. Doing so will help you understand how to use this software library. The operation of many of the essential features is not immediately obvious and we realize that many users are not music technologists.

The ARIA Player has a separate manual that can be found in the same directory as this file. Please refer to the separate ARIA Player User's Guide for information about registering, activating, and using ARIA. The ARIA User’s Guide is an important part of the documentation.

We'll do our best to make it easy for you to use this manual and to provide information about the various harps and modes of control. And, of course, by no
means can harp performance and technique be taught from this or any other manual. Individual study and research will enhance your ability to use this library.

This manual is provided in digital form as an Adobe Acrobat document file (also known as a PDF) that can be viewed on a computer display or tablet computer, or it can be printed. If you do not have the Adobe Acrobat Reader, it is available free from www.adobe.com. A digital manual is eco-friendly and can be easily updated. If you need to have a paper copy, you can print this document or order one at www.lulu.com.

The easiest way to obtain the information you seek is to use Adobe Acrobat’s Bookmarks pane along the left side of this PDF document. If the Bookmarks pane isn’t open, click the button to open it. Bookmarks allow you to quickly access the various topics from the section names. With a PDF document, you can also zoom in to make the page larger to see more details or zoom out to see multiple pages at once. On any page, click the footer text “User’s Guide to Garritan Harps” to return to the Table of Contents on page 4.

COMPUTER SYSTEM REQUIREMENTS

The following table lists the computer and hardware requirements for using Garritan Harps. You can use the ARIA Player on most any modern personal computer that meets the specifications listed below. The specifications provide the minimum standards.

If you are using Garritan Harps within a host music program (such as a notation program, DAW, and/or sequencing program), there may be additional resource requirements. Please also observe the system requirements of your host application, if applicable. The demands of any additional processing software (including the sequencer, audio and effects processors, other plug-ins, and so on) can affect functionality.
### COMPUTER SYSTEM REQUIREMENTS

<table>
<thead>
<tr>
<th>Computer</th>
<th>Operating System</th>
<th>Hardware</th>
</tr>
</thead>
</table>
| **Windows PC** | Microsoft Windows 7  
Microsoft Windows Vista  
Microsoft Windows XP (SP3 required) | Core 2 Duo CPU or later recommended.  
2 GB RAM recommended. There is a direct correlation between the amount of available RAM and the number of sounds that can be loaded.  
4 GB of free hard drive space.  
Hard drive speed of at least 7200 RPM recommended.  
Internet connection for updates and online registration.  
Monitor with 1024x768 resolution or higher.  
A professional sound card compatible with ASIO.  
A MIDI interface may be required if you are using a MIDI keyboard. Many keyboards now use USB.  
The ability to assign controllers within your keyboard, music program, or sequencer is recommended.  
High-quality speakers and amplifier, or high-quality headphones. |
| **Mac** | Mac OS X 10.6 minimum | Mac Intel CPU (PowerPC not supported).  
2 GB RAM recommended. There is a direct correlation between the amount of available RAM and the number of sounds that can be loaded.  
4 GB of free hard drive space.  
Hard drive speed of at least 7200 RPM recommended.  
Internet connection for updates and online registration.  
Monitor with 1024x768 resolution or higher.  
A professional sound card compatible with Core Audio.  
A MIDI interface may be required if you are using a MIDI keyboard. Many keyboards now use USB.  
The ability to assign controllers within your keyboard, music program, or sequencer is recommended.  
High-quality speakers and amplifier, or high-quality headphones. |
REGARDING SOUND CARDS, AUDIO & MIDI INTERFACES

The quality of your audio interface will have a significant effect on the quality of the sound you will hear from Garritan Harps. It will also have a substantial effect on performance (both latency and polyphony). Therefore, a good sound card is one of the most important components in optimizing the sound and performance of Garritan Harps.

In theory, any audio or sound interface that the manufacturer supports for your operating system and computer, and that has good drivers, should work. However, you are unlikely to get the best results from a sound card designed for computer games or system sounds. Most computers come with a consumer-grade sound card; we recommend that you get a good quality sound interface beyond the one built into your computer. Older sound cards that do not support multiple sample rates, as well as gamer-oriented or home system sound cards, may be problematic. It is not possible for us to test all built-in or third-party sound cards, and some interfaces do have problems on certain platforms, so please see the specifications page on the Garritan website if you are considering buying a new sound card to run Garritan Harps.

A low-latency audio interface with WDM/WaveRT drivers (Windows), Core Audio drivers (Mac), or ASIO drivers is required for Garritan Harps to work as a standalone program. These drivers are normally installed with the audio interface; the most recent version can be acquired from the manufacturer’s website. Contact the manufacturer of your interface for more information.

Any MIDI interface the manufacturer supports for your system should also work with Garritan Harps. There are a few dedicated harp MIDI controller setups on the market. They are expensive and require proficiency in playing the harp, but may be worth exploring.

NOTE:

When Garritan Harps is running as a plug-in, it uses the audio driver specified in the setup of the host program. If the host (typically your sequencer or notation program) is set up properly and works well, then the ARIA Player plug-in should pass through the same audio and MIDI setup. For more information, please refer to the manual for your sequencer or notation program.
REGARDING SPEAKERS, AMPLIFICATION, AND HEADPHONES

The combined quality of your audio amplifier and speakers is extremely important; there is little point in expending a great deal on a high-end computer system and audio interface but using inferior personal computer speakers. Good quality speakers or headphones are important for faithfully reproducing the sound of a virtual harp. The pedal harp has a wide dynamic range, and can span up to six and a half octaves.

REGARDING 64-BIT COMPUTING

As more hosts, operating systems, and hardware become 64-bit enabled, it is important to know if the software you use provides 64-bit support. Garritan Harps and the Garritan ARIA Player are 64-bit compatible and take full advantage of 64-bit operating systems, processors, and hardware that are available. They are also fully 32-bit compatible. To operate as a true 64-bit application, the entire audio path must be 64-bit, including sampler, host, operating system, audio, and MIDI hardware.
INSTALLATION AND ACTIVATION
INSTALLATION

Below is a quick reference for installing Garritan Harps. For a complete guide to installing the ARIA Player, please refer to the separate ARIA User's Guide included with Garritan Harps.

Installing Garritan Harps is a three-part process:

3 STEPS FOR INSTALLING GARRITAN HARPS:

Step 1. ARIA Installation
Step 2. Sample Library Installation
Step 3. Activation

Installing the ARIA Player and the sample library are separate processes. ARIA is installed first, followed by the Garritan Harps library.

Windows Setup: To begin, extract the contents of the downloaded zip file to a folder of your choosing. It is critical that you extract the entire zip file before running the installer. Once the contents have been extracted, double-click on the installer and follow the on-screen prompts. If you have the DVD version, just double-click on the installer.

Mac Setup: To begin, extract the contents of the downloaded zip file. Double-click on the mpkg installer and follow the on-screen prompts. If you have the DVD version, just double-click on the installer.

You will be given the option to install several components:

Standalone will install the Garritan ARIA Player as its own software program. You can play instruments, record basic MIDI, and render audio files.
VST Plug-in will install the Garritan ARIA Player as a VST plug-in for use in sequencers such as Cubase, Sonar, and Reaper, as well as notation programs such as Finale.
AU Plug-in (Mac only) will install the Garritan ARIA Player as an Audio Units plug-in for use in sequencers such as Logic and Digital Performer, as well as notation programs such as Finale.
RTAS Plug-in will install the Garritan ARIA Player as an RTAS plug-in for use in Pro Tools M-Powered, LE, and HD.
Once you have selected your installation options, you can specify which parts of the sample library you want installed. We recommend you install the entire library.

At this point, you can sit back and let the installer do the work. If you have the download version, you can delete the extraction folder once Garritan Harps is successfully installed. Before doing so, however, we suggest you make a backup copy of the installation zip file and put it in a safe place. If anything happens to your computer, you can reinstall Garritan Harps from the discs or the backup file, or you can download the installer from your account at www.garritan.com/support.

**IMPORTANT:**

Do not cancel setup after installation begins: an incomplete, non-functional installation may result.
ACTIVATION

After the sample library has been installed, it must be activated. You have 30 days from the time you install the library before activation is required. Garritan Harps features an innovative drag and drop authorization system.

Click Generate Key Cards and login to your account. If you don’t already have an account, create a new account to be able to generate your key card.

Log in with your e-mail address and password. Enter your serial number, which you can find on the inside of the DVD case that contained your installation disc.
On the following screen, right-click (Windows) or CONTROL+click (Mac) on the key card and choose Save As.

Save the key card PNG to your desktop. Launch the ARIA Player in standalone mode. Click and drag the key card PNG icon from the desktop onto the ARIA Player screen. A message will appear indicating that Garritan Harps has been activated.

You can transfer your key card PNG image file to a flash drive if your music computer does not have Internet access. You can download your key card at any time by logging in at www.garritan.com/support.

**IMPORTANT:**
The key card contains your personal information. Don't lose this—we recommend saving your personalized key card to a safe place for future installations.
ARIA PLAYER BASICS
NAVIGATING THE ARIA PLAYER INTERFACE

1. The **active instrument** light shows you which instrument's parameters you are changing. Click this location on another instrument slot to change the focus of the controls.
2. The **instrument display** features a drop-down menu for loading instruments which appears when the field is clicked.
3. **Tuning controls** let you control fine tuning.
4. **Stereo output assignment** allows you to route instrument slots to as many as 16 unique stereo output channels when ARIA runs as a plug-in.
5. **MIDI channel assignment** allows you to specify the MIDI input channel for the instrument slot.
6. **Per-instrument sends** let you apply the desired amount of reverb to each instrument slot.
7. **Mute and Solo** buttons let you mute or solo the individual channels so you hear only certain parts in a mix.
8. **Graphical faders** give you a quick idea of an instrument’s presence in the mix. The faders respond to CC#7 commands.

9. **Keyswitch window** displays the active keyswitch (if keyswitches are available in the loaded instrument).

10. A **keyboard** shows the range of notes that can be played on that harp instrument in white, keyswitches in pink, and the selected keyswitch in beige.

11. **Window tabs** switch the display to the Info, Controls, Mixer, Effects, or Settings window.

12. **Ensemble presets** allow you to quickly load instrument groups and combinations. Please refer to the section on Ensemble Presets later in this manual for a list of presets.

**SEE ALSO:**

For more information about the features of the ARIA Player, please refer to the ARIA User’s Manual.
USING THE ARIA PLAYER

Once installed and activated, you can load the instruments of Garritan Harps in the ARIA Player. There are several ways to use Garritan Harps with the ARIA Player: you can play it “live” as a standalone application or as a plug-in within a sequencer or notation program.

USING ARIA AS A STANDALONE

If you have installed the standalone version of the ARIA Player, you can find it in your Applications folder (Mac) or Start menu (Windows). ARIA will attempt to determine the best audio playback configuration to use on your machine. You can access ARIA's playback system by choosing Preferences on the Tools menu.

To use a MIDI keyboard with Garritan Harps, make sure to have the device drivers installed and the unit turned on before starting the ARIA Player Standalone. Your MIDI control device should appear in the MIDI Input Devices menu of the Preferences dialog.

The Ensemble Presets allow you to use preconfigured or user-created templates, saving a significant amount of setup time. You can also load instruments in each slot and click File > Save to save the custom preset. Clicking File > Save As Default saves all settings and instruments that are currently chosen so that they automatically load each time you start the program.

The standalone ARIA Player also features a MIDI and audio recording system located on the bottom of the screen. With these controls, you can load existing MIDI files for the ARIA Player to play back using Garritan samples. You can also record yourself playing live.

USING ARIA AS A VST, AU, OR RTAS PLUG-IN

Depending on your system and the options you selected at installation, you may have one or more of these plug-in formats available.

Configuring VST

At installation you will be prompted for the vstplugins folder directory. The installer will attempt to locate an existing vstplugins folder, or you can specify your own. You can always find the ARIA Player VST plug-in in the Garritan/ARIA Player/VST directory. The VST plug-in ends in a .dll extension. In your host’s
VST plug-in configuration menu, ensure that the installation directory that you specified is included in the list of VST directories. You may need to re-scan the folders to have ARIA Player VST appear in the list of software instruments.

From there, just load the ARIA Player and go! You will find the VST listed as ARIA Player VST.dll, which contains a single stereo output, and ARIA Player Multi VST.dll, which allows you to assign up to 16 stereo outputs. On 64-bit Windows systems, both 32-bit ("x86") and 64-bit ("x64") versions of the VST plug-in will be installed.

**IMPORTANT NOTES FOR PC USERS:**

To use the ARIA Player with more than one VST host program, you need to manually copy the ARIA Player VST_x86.dll, installed into the chosen folder during installation of the library, to the appropriate host program’s VST folder. Please refer to your particular host program’s user’s guide and the Garritan support site for more information.

Regarding 64-bit hosts: Some hosts have one common VST folder for both 64-bit and 32-bit plug-ins; please only use the version of the plug-in that is native to your host. Mac OS X has standard folders for both VST and Audio Units plug-ins and does not require this extra step.

**Configuring AU (Audio Units—Mac Only)**

The ARIA Player will install into the default Mac OS X AU plug-ins folder, after which it will be readily available to your host programs.

**Configuring RTAS (Pro Tools systems only)**

The ARIA Player will automatically install the RTAS plug-in to its proper location to work with Pro Tools.

**SEE ALSO:**

For more information about using the ARIA Player, please refer to the ARIA User’s Manual.
ABOUT THE HARP
A BRIEF OVERVIEW OF THE HARP

Harps are one of the oldest and most recognized instruments. The harp is a multi-stringed instrument that is typically played by plucking with the thumb and fingers.

There is no such thing as a “standard” harp and they come in many sizes and varieties. The most common types of harps are the concert pedal harp and non-pedal harps. The concert pedal harp is the type of harp many people are most familiar with, as it is often seen in a symphony orchestra.

Non-pedal harps include many types of folk harps, Celtic and Irish harps, lap harps, Latin harps, and various ethnic harps. Students often begin by learning the non-pedal harp before moving on to a pedal harp.

A person that plays a concert pedal harp is called a harpist and a person that plays a folk harp is called a harper.

HARP STRINGS AND RANGE

Many are familiar with the gentle sounds of the harp. Harp strings are usually plucked with the tips of fingers of both hands. Some traditions (such as South American harpers and wire-strung harpers) play with their fingernails. Once plucked, the sound of the string will slowly die away. The player can shorten this decay by dampening immediately after plucking the string.

Only four fingers of each hand are used to play the harp. The little finger is rarely used because it is considered too short and weak to effectively pluck the strings.

The three main types of harp strings are gut, nylon, and wire. Concert pedal harps usually use gut strings, which have high tension but a relatively short life span. They are rather expensive and some harpists are opting for carbon fiber or synthetic gut strings. Nylon and composites are used in many non-pedal harps and the tension is usually lower. Wire-strung harps have a different sound and are normally only found on historic folk harps.

Concert harps and most folk harps have several different colors of strings: red, dark blue and clear. The “C” notes are usually red, the “F” notes are dark blue, and the remaining strings are clear. The color coding is handy for the harpist to locate strings at a glance.
Concert pedal harps typically have 47 strings, or six-and-one-half octaves, nearly the range of the piano. The lowest string is a C, just three notes above the piano’s lowest A. The highest string is a G, just four notes below the piano’s highest C. The average concert pedal harp has a height of approximately six feet and can weigh as much as 90 pounds; the pressure exerted by the strings on the soundboard of a concert pedal harp can be as much as 4,400 pounds. The following is the typical range of a Concert Pedal Harp:

Non-pedal folk harps usually range from 20 to 40 strings and employ sharping levers rather than pedals. The range of a folk harp varies according to type and size. They are often tuned to a specific key.
The above illustration labels the parts of a pedal harp. The parts of a non-pedal harp are similar except that sharping levers are used instead of pedals.

**Crown** - The crown is situated at the top of the harp and rests atop the pillar. It is in the shape of a crown, hence its name.

**Tuning Pins** - The tuning pins are tapered metal pins that go through the neck of the harp and fasten the strings to the instrument. The tuning pins are turned to tighten or loosen the strings, adjusting their pitch.

**Pillar** - The pillar (or column) is the vertical part of a harp. The top of the column is attached to the neck of the harp and the bottom of the column attaches to the soundbox.

**Neck** - The neck (or harmonic curve) is the upper, curved part of the harp connecting the column to the soundbox and securing the tuning pins.

**Soundbox** - The soundbox (or sound chamber) is the hollow part of the harp attached to the pillar at its lowest point, and to the neck of the harp at its highest point. There are sound holes in the back of the soundbox facing the harpist. These sound holes help amplify the notes of the harp.
Soundboard - The soundboard is the flat surface of the soundbox located on the string-side of the harp. Soundboards require a high-quality wood such as Sitka spruce, which expert luthiers believe provides the best tone to the harp.

Shoulder - This is the curved part of the harp that connects the neck to the soundbox. The shoulder of the harp rests near the harpist’s right shoulder with the right arm wrapping around the instrument.

Pedestal or Base - The base connects the column to the soundboard and is where the harp pedal mechanism is situated.

Feet - The feet are located on the bottom of the base and enable the harp to stand on its own.

Strings - The strings of the pedal harp are tuned similarly to the white keys on a piano. The red strings are the “C” notes, the dark blue strings are the “F” notes, and the clear strings are the remaining notes.

Pedals - The concert pedal harp has seven pedals. Three pedals are controlled by the left foot and the remaining four are controlled by the right foot. See the section below for a more detailed discussion of the harp pedals.

PEDALS

Harp pedals are much different than pedals on a piano or the pipe organ. The concert pedal harp that one sees in an orchestra has seven pedals, not easily visible unless one is close up to the instrument. It is fascinating to watch a harpist’s feet dance over the pedals. Imagine playing with both hands and both feet!

There are seven pedals corresponding to the seven notes of the scale - C, D, E, F, G, A, and B. These pedals change all octaves of any given note simultaneously. The pedals are mechanically attached to discs near the tops of the strings and are used to change the length of the strings of every octave of each note.

Each pedal has three positions. The first notch (center) position corresponds to natural notes, the second notch (bottom) to sharp, and the upper position to flat. For example, by moving the C pedal to the second notch, the harpist switches every C string to C#. The same applies to the other notes of the scale, making it possible to play in all keys.
Pedaling allows the harpist to change keys reasonably quickly, but composers and arrangers should allow extra time for pedal changes before the new notes are required, especially if there are several simultaneous pedal changes.

Harpists must remember to check the pedal positions before tuning, and then tune the harp in the desired key.

**LEVERS (FOLK HARPS)**

Lever harps, or folk harps, are small to medium-sized harps with limited chromatic capabilities. These harps have a manually controlled flip-up lever at the top of each string that can raise the pitch of each string by one half-tone when engaged (flat to natural or natural to sharp). The levers are attached to the neck of the harp below the tuning pegs. The player's left hand usually changes the lever positions.

**GLISSANDI (GLISSES)**

The glissando (plural glissandi) is one of the most beautiful and characteristic effects associated with the harp. It is played by rapidly drawing one or more fingers across a succession of adjacent strings in an upward or downward motion. They can be played with the right, left, or both hands, in either ascending, descending, parallel, or contrary motion. To play glissandi on a pedal harp, a harpist raises or lowers the required pedals to produce desired scales or chords. Glissandi are usually played using single notes with one or both hands, but multiple glisses are also possible with more than one finger. Glisses performed on non-pedal harps are much more limited and sometimes require certain notes be retuned or muffled.
Glisses can be diatonic or enharmonic. A diatonic glissando is played using all the notes of the scale of a given key. An enharmonic glissando is intended to suggest a particular chord. With the use of the pedals, the harpist can double certain notes and eliminate clashing notes in order to produce a compatible chord for the glissando.

Garritan Harps has a variety of options for playing glisses. It is our hope this library takes away some of the anxiety and makes harp glisses more accessible.

SPECIAL EFFECTS

**Harmonics**

Harmonics are produced by slightly stopping a string at its halfway point with the flesh of the hand while plucking the string with the finger. The resulting sound is ethereal and bell-like, sounding an octave higher than the written string tone. Harmonics sound best when played in the middle register of the instrument. Standard notation for harmonics places a small “o” above the note.

Double and triple harmonics are possible but rare. Up to three harmonic notes in close range are possible with the left hand and one harmonic note with the right hand.

**Près de la table**

Près de la table is a special technique of playing near the soundboard (close to the base of the strings rather than the normal playing in the middle of the strings). Strings plucked near the soundboard produce sounds that are brighter and more metallic.

**Damping**

Damping, also called muffling, is the stopping of the vibrating string with the hand soon after it is plucked. When not specified, it is assumed that the sound of the note played will fade away naturally. When there is a “+” under the note, that indicates to play the note “étouffez” or slightly damped with the thumb, so that each string is damped as the next string is played.
Chords and Arpeggios

A chord is the sounding of more than one note simultaneously, similar to playing a chord on a piano. An eight-note chord is the largest chord possible, as a pedal harpist plays with only four fingers per hand. The range of the chord is also limited to the span of the harpist's hand, which typically ranges from an octave to an octave and a fourth.

Arpeggios are chords where the notes are played in succession rather than plucked simultaneously. Slight arpeggiation is the default method that harpists use to play chords if there is no other indication. An arpeggio can be played from bottom to top or top to bottom. Arpeggios played very fast while alternating both hands sound terrific (e.g. the Nutcracker harp cadenza).

Trills, Tremolos, and Bisbigliando

The harp is capable of playing quickly-repeated notes including trills (alternating multiple pitches), tremolos (rapidly repeating one pitch), and bisbigliando. Trills and tremolos are typically notated in the same manner as the piano. Tremolos are easier if enharmonics are used, alternating two strings tuned to the same enharmonic pitch (e.g. G# and Ab).

Bisbigliando is a special tremolo effect on the harp where a chord or note is rapidly repeated at a quiet volume to sound like whispering. To play bisbigliando, the harpist usually plays with both hands very lightly.

These are some of the most common special effects for harps. There are other effects that professional harpists also employ.
NOTATING FOR HARP

Harp parts are notated on the grand staff, with the right hand playing in the treble clef and the left hand playing in the bass clef, similar to a piano. Harpists generally play with four fingers of each hand and the little finger is rarely used. Therefore, a maximum of eight simultaneous notes are written for the harpist.

Harp music often indicates whether the right or left hand plays the notes. This is noted as m.d. for the right hand and m.g. for the left hand.

To notate a glissando, the score will indicate the pitch of the starting and ending notes, with a straight line between them with the word gliss(ando).

The harpist’s score typically indicates the initial pedal settings (for example, D C# B♭ E F# G A♭). A pedal diagram, which is a visual representation of the pedals, is common in harp notation; an example is provided below.

![Pedal Diagram]

A horizontal line represents the first position (natural) of the pedals and a large vertical line represents the middle of the harp with the left foot pedals (D C B) to the left of it and the right foot pedals (E F G A) on the right. Pitch changes are usually notated a bar or two in advance to give the harpist time to make pedal changes.
A BRIEF HISTORY OF THE HARP

The history of the harp goes back thousands of years. The harp is the oldest known stringed instrument. The piano, the guitar, the violin and all other string instruments evolved from the harp. Throughout the ages, the harp has had an impact on almost every culture. Harps have been regarded as sacred and have been instrumental in the healing process, in the celebration of birth, as comfort in passing, and to make people feel better. No other instrument has been so closely associated with so many positive things: with a profound sense of beauty, with peace and tranquility, with love, with enchantment, with goodness, and with heaven.

The word harp comes from Anglo-Saxon, Old German, and Old Norse words whose root means “to pluck”. Scholars disagree as to what exactly a harp is. The names early musicians gave their instruments are not the names we give those instruments today and the names of instruments in the ancient world were interchanged. Harps in my definition are multi-stringed instruments with open strings (no frets) plucked with the fingers where each string plays one note. This would include medieval harps, baroque harps, Irish harps, Celtic harps, Spanish harps, Chinese harps, African Harps, as well as related instruments like lyres, zithers, clàrsach, kitharas, psalteries, arpas, yazh, cheng, kotos, koras, and other stringed instruments. The evolution of the harp followed paths of human migration and also coincided with the development of musical scales in each culture. The harp’s development reflected physical, cultural and economic environments such as trade, religion, environmental changes, and technology.

PREHISTORIC TIMES

No one really knows where the harp originated and we will never know what music sounded like at the dawn of civilization. One of the earliest musical instrument relics, discovered in France at the cave of the Trois-Frères on rock paintings dating back to 15000 BCE, shows a harp-like instrument. Many believe that the earliest harps were modeled after the hunter’s bow. Perhaps while hunting, prehistoric humans liked the sound of the vibrating bowstring. Then a second string was added to the bow, followed by a third. Over the course of time, more and more strings were added. Eventually, a gourd or a hollow area at one end of the bow was added, becoming a sound box. This came to be known as the arched harp, which the Egyptians later perfected.
ANCIENT EGYPT

Of all the musical instruments in ancient Egypt, hieroglyphics seem to show that the harp was the most popular. Some of the earliest depictions of Egyptian harps are from the tombs of the Pharaohs, dated to around 5,000 years ago. Music played a great part in ancient Egyptian life. They regarded musical instruments and music itself as originating from the gods. Harps were used in harp ensembles, in festivities and banquets, in funerals and in temple worship. The Egyptians played mostly arched harps - where the neck and body form a bow-like curve or “C”-shaped soundbox, forming the resonator of the instrument. The harps were mostly played in a vertical position. The Egyptian Pharaoh Ramesses III (1186–1155 BCE) had many harps depicted among paintings in his tomb. In the New Kingdom, harps measuring up to 6-1/2 feet in height with 19 strings had to be played standing up. Many illustrations show the hands are on different strings with wide gaps between the hands.

MESOPOTAMIA

As in Egypt, harps were very popular in ancient Mesopotamia. One of the earliest illustrations of a harp in Mesopotamia was on a vase found during an excavation of a Babylonian temple near the Tigris and Euphrates Rivers. These harps were arched harps with 12 to 15 strings, not unlike the instruments that were played in Egypt at about the same time. Mesopotamian arched harps were played with the soundbox held above the strings, whereas in Egypt the resonator was held below. The Mesopotamians later developed other types of harps. The angle harp differed from arched harps in that the neck and the body form right angles. Vertical harps, also known as lyre harps (or just lyres), began appearing in ancient Sumeria by 2800 BCE. A lyre usually had two arms of wood extending out from the instrument’s body. The arms were connected at the top with a stick or crossbar to which strings were wound. The strings were stretched from the crossbar to the instrument’s body. In box lyres, the body and belly formed a hollow wooden box; in bowl lyres, the body was made from a tortoise shell, gourd or carved bowl, and the belly was usually an animal skin.

PALESTINE & BIBLICAL TIMES

Much of the imagery and concepts of harps we have come from the Bible. The harp is the first instrument mentioned in the Bible. One of the earliest archaeological finds including a harp was near Jerusalem. A cave drawing from
the 3rd or 4th millennium BCE was discovered in Megiddo that depicts a man playing a frame harp known as a nevel. Legend has it that the sound of the nevel was so sweet that when all the other musical instruments heard it they became ashamed. In the Bible, Jubal was “the ancestor of all who play the harp” (Genesis 4:21), and it is mentioned that King David was “skilled in playing the harp”, playing it as a shepherd while sitting in the fields and composing his psalms. Although no one knows exactly what David’s harp(s) looked like, the Bible does say that David played very well and prevented King Saul from going mad: “… David would take up his lyre and play. Then relief would come to Saul; he would feel better, and the evil spirit would leave him” (Samuel 16:23). This seems to be the oldest recorded case of harp therapy.

Harp lyres were used in the Temple of Jerusalem as a regular part of the worship service. One depiction of a harp that existed close to the time of Jesus was shown on a coin issued during the Bar Kochba revolt called a Zuz. On this coin is shown a small harp called a kinnor, the kind that was probably used in the Temple Service. Tradition has it that the Jews refused to play the harp when they were exiled in Babylon. Instead the Harp of David was hung upon the willow trees. The harp of the Temple was forever silenced and disappeared. Ancient Talmudic prophesy (Mas. Arachin 13b) says that harps will usher in the coming of the Messiah. “The harp of the ten strings is reserved for the day when the world that is to come (the Olam Haba) is united in one harmonious whole.” In the last book of the New Testament, Revelation 14:2 states “And I heard a voice from heaven, as the voice of many waters, and as the voice of a great thunder: and I heard the voice of harpers harping with their harps.”

**HARPS**

ANCIENT GREECE

Some of the oldest carvings of harps were discovered in Phoenicia. Eleven marble harp statuettes dating back to between 3000 and 2300 BCE were found on the island of Keros in the southern Aegean Sea. It was found at Keros and dates from the Early Cycladic period (2800-2300 BCE). These figurines are playing triangular-shaped harps. In the 5th to 6th centuries BCE, Pythagorus discovered numerical ratios corresponding to intervals of the musical scale. Greeks began to write songs based on these scales and the small lyre harp was ideally suited to play songs in these scales. The ancient Greeks valued the ideals of beauty and ethics and music played an important part in Greek life. The Greeks considered the art
of playing musical instruments to be a principal part of learning. The lyre harp lent itself nicely to these Greek ideals and later became the most popular instrument in Ancient Greece.

The classic Greek lyre harp was the kithara, which was a term used for describing all kinds of harps and lyres. Our modern word guitar comes from the word kithara. According to Greek mythology, Hermes created the lyre harp from the body of a large tortoise shell, which he covered with animal hide, with antelope horns forming the posts. So beautiful was the tone that he presented the instrument as an offering to the god Apollo. The lyre harp was thus regarded as the instrument of Apollo, the god of music and harmony. Lyres came to be associated with the higher Apollonian virtues of wisdom, serenity, clarity, moderation, and communication. In contrast, the music of the Dionysians was performed on raucous reed instruments with wild abandon. Greek mythology holds that Orpheus, the divine lyre harp player, in order to bring back his wife from the dead, charmed Pluto, the lord of the underworld. Orpheus played this lyre harp to inspire Jason and the Argonauts on their quest for the Golden Fleece. It was Orpheus' melodies that blocked out the brainwashing sirens, who were intent on inciting listeners to their destruction. The Greeks are also credited with inventing the Aeolian harp, a harp played by moving air. It was named for Aeolus, the Greek god of the wind.

THE FALL OF THE ROMAN EMPIRE AND DARK AGES

When Greece was conquered by Rome in the second century BCE, there was an influx of Greek art into the empire. Nevertheless, Ancient Rome did not seem to place as high an importance on music as did the other ancient civilizations. For the most part, only martial music was valued in Rome; the Romans possessed a large number of military horn instruments and drums. Harps did not fit well with the military state. The culture of brutality left little appreciation of the esoteric tones of the harp. Music was regarded by the state as worthless or belonging to commoners and not befitting to the education of its younger citizens. Needless to say, music degraded over time, as did many other aspects of this society. With the decline of the Roman Empire, music seemed to have died out, and there are very few historical references for a number of centuries following. In European society after the fall of Rome, depictions of harps were found on the coins of pre-Christian Gauls. These U-shaped instruments, may have come to western Europe from southwestern Asia with groups of Indo-European peoples who spread across Europe. The harp and culture in general seems to have disappeared in the Dark Ages. These first few centuries CE are shrouded in mystery.
ANCIENT ASIA

Meanwhile, further east in Asia, the development and use of the harp flourished as the Chinese developed elaborate instrumental orchestras that included harps. Ancient Chinese writers speak of the number of strings on musical instruments decreasing to help prevent arousing the dangerous depths of the soul. In the works of Confucius (551–479 BCE) many instruments are described, including harp-like instruments. Confucianism spoke of music which “soothed the savage breast”. Chinese harps were known to have existed in the Shang Dynasty (1600–1046 BCE). In the Han Dynasty (206 BCE–220 CE), the konghou frame harp was believed to have been brought into China by Persian merchants via the Silk Road. The konghou looks very much like some modern harps. Figures playing the konghou harp in a musical ensemble, along with panpipes, drums and pipas (a type of lute), are depicted in the lavish Dunhuang processional mural paintings. The konghou harp was a popular instrument in the royal courts during the Sui and Tang Dynasties and poems were written praising its beautiful color and tone. A similar instrument called the kugo was introduced in Japan in the tenth century CE. For some unknown reason, the konghou slid into obscurity during the Ming Dynasty (1368–1644 CE), and Asian harps began to take on a different shape. Horizontal harps (where the strings run parallel to the soundbox) began a long tradition in East Asia. In China, the guzheng (pictured above left) became very popular. In Japan, a similar instrument, the koto, became the most revered musical instrument.

In India, the harp has had a colorful history. Music in India has always played a significant role in the lives of its people. The history of the harp in India goes back thousands of years. Harps that had hundreds of strings were known to exist! There is an ancient Indian saying, “Listening to the playful melody of a harp (yazh), puts one into a state of spiritual ecstasy that makes one forget the worldly pains that one goes through”. Indian scholars believe that the hunter’s bow was the first type of yazh harp. An ancient Sanskrit manuscript, the “Kannanar”, tells a story of the hunter Vedan using the bent branch of a tree and vegetable fibers for strings to make an instrument to accompany his song. Many ancient Sanskrit texts provide many names given to harps, such as Adi yazh, a 1000-stringed harp used for chasing away wild animals; Narada periyazh, a 1000-stringed yazh in a triangle shape; Adi kala periyazh, a 100-stringed instrument; Periyazh, a 21 stringed instrument; Kichaka yazh, a 100-stringed yazh; and many others. The whole universe, according to Hindu mythology, originated with the sound of
the “Om”. Then seven notes were born from the five faces of Shiva. India later developed more notes and the harps were built to accommodate these notes. The Bharata Natyam, written in the second century BCE, described the octave and divided it into 22 notes. This was discovered while playing the yazh harp and developed the basis of the quarter tone scale which survives today. Instruments like the sitar and tambura evolved from the yazh, becoming the popular stringed instruments of India today. For some unknown reason, the yazh stringed instruments became extinct. In Burma (Myanmar) a harp known as the saung survives to the present day and has many similarities to the ancient Egyptian harps.

MIDDLE AGES - MEDIEVAL HARPS

After centuries in obscurity, the harp reappeared in Western civilization. The emergence of Christianity brought with it respect for the instruments of the Bible, especially the harp. In the fourth century CE, monotone chanting was used in worship services in the church; eventually, more notes were added, in time evolving into Gregorian chant. The harp became a preferred accompaniment for the monks' voices. A Cambridge manuscript describes the harp as one of the few permitted instruments in the early church, whereas the horn, drum and rattle were regarded as the devil's instruments. The fifth century brought forth the King Arthur legends, in which the magician Merlin was believed to have played the harp. Also during the fifth century, a Papal music school was established in Ireland and the harp was taught.

Fragments of a six-stringed harp were found in the 7th-century Sutton Hoo burial ship unearthed at Suffolk, England. The depiction of a harp was also discovered in stone carvings dating from the 7th century CE in Hexam, Northumberland in the British Isles. The earliest known mention of the word harpa occurred about 600 CE by Venantius Fortunatus, the Bishop of Poitiers. In northern Europe, the Germanic tribes played a type of lyre harp. Mentioned in Beowulf, the harp may have been the instrument to accompany the performance of Anglo-Saxon poems and stories. The remains of several such Germanic harps, dating from the fifth through the tenth century, have been found in Saxon and Frankish graves in England and Germany. The earliest drawings of harps with columns appear in the Utrecht Psalter, written and illustrated in the early ninth century. Many of these illustrations show figures holding harps, and in six of them the column or forepillar is clearly shown. The harp played by the harpers of the old Gaelic order was an aristocratic instrument, played in the courts of kings and before the chiefs of clans. It had an important role in legend and folklore.
Beginning around the 13th century, when feudalism reached its height, the troubadours began appearing. They would pluck their harps and sing their graceful melodies and advance the cause of chivalry. European harpers earned their living by moving from town to town, using small harps for self-accompanied singing and storytelling, as well as in instrumental consorts. The harp had such mystical significance that many kings or chieftains had harpers in their employ, believing the instrument to possess magical powers. Harpers were second only to the chieftain or king, often serving as advisors and leading armies into battle in order to bring luck to the warriors, to hail the heroes, and to recount battles to the tribes and clans. Unarmed, they were recognized and respected by the enemy and were immune from harm. Richard the Lionhearted took his harper, Blondel, on the Third Crusade in the 12th century. The age of chivalry with its troubadours and minstrels began a new renaissance in harps. The medieval harps during this time were small enough to be held on the player’s lap, and had between 7 and 25 strings with narrow sound boxes. Medieval harps were apparently wire strung, typically had outcurving forepillars, and eventually were tuned diatonically (seven notes per octave). From the middle of the 14th to the 16th century, larger harps known as Gothic harps appeared. This harp had approximately 24 gut strings and was a tall instrument carved into pointed corners, similar to a Gothic arch. This Gothic harp is the ancestor of the folk harps of Latin America and of the modern Irish and orchestral harps.

HARPS IN IRISH SOCIETY

The harp has been an important emblem for Irish nationalists since the 10th century CE. Although the Irish are generally credited with bringing the harp to Europe, scholars believe it was brought to Europe from Egypt. Irish fables speak of the Dagda, a god who played the harp to welcome springtime. The earliest images of an Irish harp appear in metal and stone etchings made during the 11th and 12th centuries. King Gruffydd ap Llywelyn of Wales employed harpists in his court at the end of the 11th century. By the end of the 12th century, manuscript illustrations depict harps with more advanced designs. The neck of the harp became curved so as to make the middle strings a little shorter, a feature that gave the strings a more uniform tension. It is reported by Giraldus Cambrensis that the Irish were by then playing harps with brass or bronze strings.
Records from the 15th century show that both the terms harp and clàrsach were in use at about the same time and seemed to have denoted a distinction between the gut-strung European-style harp and the wire-strung Gaelic clàrsach. The earliest surviving harps from Scotland and Ireland date to approximately the 15th century. The characteristic shape of an Irish harp is familiar from Irish coins and bottles of Guinness Beer. The Trinity College harp, one of Ireland's national treasures, is the harp from which the national symbol of Ireland is copied. Henry VIII of England had the Irish harp impressed on coins after obtaining control over Ireland.

For centuries, the harp was an integral part of Irish life. Traveling harpists in Ireland were known to be at the focal point of rebellions—so much so that the harp was banned from time to time. In the 1700s, some harp players wrote down old folk tunes in music notation. Bunting's history of the harp collected these Irish compositions. Turlough O'Carolan (1670-1738), the blind Irish folk harpist, wrote over 200 tunes, many of them still very popular today. The harp remains an important and integral part of Irish culture.

THE CULTURES IN THE AMERICAS

Very little is known about the music of ancient American cultures. There is scant evidence showing that multi-stringed harps were ever made by the indigenous people of the Americas. They are generally thought to have been introduced during European conquests and colonization. The Jesuit missionary and music teacher Anton von Sepp Rechegg wrote in 1692: “The Indians built very good musical instruments, among them trumpets, clarinets, harps... “ Harps are still built and played by the Tzotzil, Mayo and Yaqui indigenous people of Mexico, who developed the harp as a folk instrument. From Spain the harp was taken to the new world by missionaries and developed in a completely different way. The indigenous peoples were fascinated with the instrument; they made some changes to it and adopted it as part of their own culture.
There are many kinds of harps in Latin America, including the Mexican harp and two different Venezuelan harps, arpa mirandina and arpa llanera (harp of the plains). Almost all South American countries have their own versions of harps. In construction and playing techniques, these harps are quite different from the traditional European harps. They are made of thin wood (cedar and pine) and are much lighter than the European harp. The playing style and techniques are vibrant and dynamic in contrast to the softer European tone. Most South American harpists do not read music; many of the folk songs have been handed down from generation to generation. The Paraguayan harp is the most popular of the South American harps and is the national instrument of Paraguay. It has 36 nylon strings tuned to the diatonic scale, is played with the fingernails, and has a bright tone quality. At right is a picture of my harp from Ecuador.

THE RENAISSANCE

By the time of the Renaissance, the organ was gaining popularity and other keyboards began appearing such as the clavichord and harpsichord. Essentially, the “harp”sichord is a mechanized horizontal harp where a string is plucked when a note on the keyboard is pressed. This was new technology, the MP3 of the time. Keyboards made it possible to play all 12 notes of the octave, establishing the 12-note system of Western music. The harp remained only capable of playing seven notes per octave. The music of the major composers in the 16th to 18th centuries demanded more notes than the diatonic harps could play. It was the lack of a full chromatic scale that was identified as the main ‘defect’ of the harp. Attempts were made to enable the harp to be more versatile by getting around its diatonic limitations. One solution was a chromatic harp, a harp with 12 strings per octave. Chromatic harps were built in Spain in the 16th and 17th century. A double harp with two rows of strings was first described in the writings of Vincenzo Galilei in 1581. Soon afterwards, the triple harp appeared, where the player would reach between two diatonic rows of strings to play the chromatic notes in between. Charles I of England was noted to have engaged a triple harpist in the mid-1600s. The earliest surviving triple harp is in the Museo Civico and dates back to the late 17th century.
Another solution to the harp's note limitations was to take the existing seven diatonic notes and change the pitch of selected strings to get sharps and flats. Hooks were first used in Tirol in southern Austria in the 17th century to sharp individual notes by hand. One drawback of the hooked harp was that a performer temporarily lost the use of the hand for plucking while making these adjustments. Although these attempts were forward leaps, they also made the harp difficult and awkward to play. Composers continued either to ignore the harp or include it sparingly for swirly effects—this despite the fact that Haydn, Weber, Rossini, Liszt, Chopin and Mendelssohn are all known to have been harp players. Bach never wrote for the harp; Handel used the Welsh triple harp only a few times in his operas and oratorios. Haydn never used it in his orchestral works, but did write one sonata for flute, harp and double bass. Mozart wrote just one work for the harp, his famous Concerto for Flute, Harp, and Orchestra in C major.

Around 1720, the Florentine harpsichord maker Bartolomeo Cristofori developed the piano. This instrument was shaped like a harpsichord, but the strings were struck rapidly with felt-covered hammers, not plucked as in harpsichords. Bartolomeo called his invention a harpsichord with piano e forte (soft and loud) and the instrument was a success. At the same time the piano was invented, the pedal harp was also invented. The first single-action pedal harp could raise the pitch of the selected strings by a half-step, allowing the harp to play in most keys. In 1720 the Bavarian Celestin Hochbrucker added seven pedals that controlled the hooks via levers set in the forepillar. Hochbrucker's single-action pedal harp was improved in 1750, when Georges Cousineau replaced the hooks with metal plates that gripped the strings while leaving them in plane, and was further improved in 1792, when Parisian Sébastien Érard substituted rotating disks for the metal plates. Érard developed the double-action harp, where a string could be both raised and lowered a half-step.

MODERN

The piano became a mass-produced instrument of the industrial revolution and grew more and more popular with the public. The harp became unpopular, being viewed as high-class. The handmade harp could not compete with the mass-produced piano. The piano was cheaper and easier to play; pianists could
perform the new music of Debussy, Ravel, Gershwin and other contemporary composers. Piano repertoire continued to grow and the number of pieces for harp dwindled. Ragtime became the newest rage and many wanted to play piano. The harp enjoyed some renewed interest when Harpo Marx, the self-taught harp-playing mute of the Marx Brothers, brought the harp to the silver screen. Harpo was an incredible harpist (and my inspiration to play the harp).

Despite Harpo's appeal and antics, the harp continued to lose popularity. The harp became so unpopular that in the 1940s, when the Royal College of Music in England decided to get rid of some instruments, two dozen harps—perhaps a half million dollars worth today—that weren't being used were simply chopped up. Harps became increasingly scarce. Only a few harps were made in the 1950s and 1960s, while, fueled by rock and roll, electric guitar sales skyrocketed.

Since the 1980s, the harp has been enjoying a comeback. Andreas Vollenweider, the Swiss harpist, electrified his harp and his audiences. Andreas played his electroacoustic harp as the lead instrument accompanied by a contemporary-style band with drums, percussion, keyboard and guitar. Vollenweider attracted a worldwide audience, sold millions of records worldwide and spawned a new interest in the harp. Harp pioneers such as Daphne Hellman and Deborah Henson-Conant showed the range of the harp's potential in jazz and other contemporary music.

The public's fascination with New Age, world, and Celtic musics also attracted interest in the harp. Canadian harpist Loreena McKennitt climbed the charts with her haunting vocals accompanied by her Celtic harp. The harp continues to enjoy a renaissance today. The popular animated television sitcom *The Simpsons* has a harp introducing its theme. Contemporary music recordings, radio, and TV regularly feature harps. There is also a swelling grassroots interest in the folk harp. Major magazines and television features have reported on the positive impact that harp music is having with patients.
THE ELECTRONIC MIDI HARP AND THE GIGAHARP

Although the traditional harp and Celtic harps were again gaining popularity, the harp had not changed much in nearly 200 years. Rapid advances in technology were made in keyboards and guitars, yet few changes were made with the harp: the technological revolution seemed to have left the harp behind. In the early 1990s, with the help of the Center for Music Research, I invented and built the prototype of the world’s first Electronic MIDI (Musical Instrument Digital Interface) Harp. The harp featured solid-body construction (more portable) and could be connected to a computer. It was capable of triggering sampled instruments, just like a MIDI keyboard or MIDI guitar. With the Electronic MIDI Harp, notes could appear on-screen while the strings were played.

Although the Electronic MIDI Harp could make many sounds, it did not sound like an authentic acoustic harp. In 1999, I developed the GigaHarp, a sample library developed for Nemesys GigaSampler which allowed not only the Electronic Harp but also any MIDI keyboard to play high-quality, realistic harp sounds. The latest advances in sampling technology made digital recordings of each individual string possible. The recordings could then be loaded into a personal computer and played back in real-time using a connected MIDI keyboard. Every note of the harp was recorded in four dynamics, from soft plucks to loud plucks. A unique harp pedal emulation was also developed to allow the pedal changes to be programmed.

Sampling is ideally suited for reproducing the sounds of the harp. Each string, with its own individuality and unique characteristics, can be recorded as high-fidelity audio and reproduced. Sampled harps can indeed sound surprisingly close to their actual stringed counterparts, especially if they are high-quality recordings. Garritan Harps takes the GigaHarp exponentially further. In addition to pure, pristine recordings of each note, new technologies allow for a variety of plucks, glissando emulation, and much more. Who ever would have thought that a virtual harp could be this good on this side of heaven? The history of the harp continues...
“The harp will always be the instrument of heaven.”
—Gary Garritan
PLAYING GARRITAN HARPS
LOADING INSTRUMENTS

With Garritan Harps it is possible to start making music within moments after installing the library. Some of the concepts/controls presented here are different than those found on a typical harp and may be unfamiliar at first. This may be more challenging for the professional harpist, but the controls of Garritan Harps are easy to master and offer some additional capabilities.

Harp patches are selected and loaded into instrument slots. They can be turned on or off with Solo/Mute buttons or controlled with volume sliders. Volume is controlled via sliders for each patch. After patches are loaded there are various ways of controlling them.

There are two basic ways to load instruments: manually load instrument patches into slots one at a time, or use ensemble templates (see section entitled “Ensemble Presets”).
Manually Load Instruments into Slots: Click the instrument slot in the ARIA Player to select the Harps instrument patches. Select empty to remove an assigned patch from a channel and choose reload to restore the default parameter settings for that patch.

The patches are grouped in a simple hierarchical menu by sample library. You can choose your Harps patches by instrument: Salvi Pedal Harp 1, Salvi Pedal Harp 2, Venus Concert Grand 1, Venus Concert Grand 2, Lyon & Healy Harp, and Gliss Harps.

You can load up to sixteen instruments for each instance of the ARIA Player (slots 1 through 16). For more slots, call up additional instances of ARIA in your sequencer or notation program. The number of instances is limited only by the power and resources of your computer and host program.

MIDI Channel Assignment: Each ARIA Player slot has an assigned MIDI channel. MIDI channel assignments can be chosen by clicking on the assignment number for the slot. This will bring up the drop-down menu shown on the left, from which you can click on the desired MIDI channel. The same MIDI channel can be assigned to more than one slot for combinations and mixtures.

Garritan Harps also includes a directory called “Ensembles” that contains a collection of useful, preconfigured combinations of patches for the convenience of the user. Simply select the ensemble preset you wish to load or recall. Loading an ensemble can give you a head start to setting up a useful collection of ready-to-play patches (see section entitled “Ensemble Presets”).

<table>
<thead>
<tr>
<th>MIDI Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>00M</td>
</tr>
<tr>
<td>01</td>
</tr>
<tr>
<td>02</td>
</tr>
<tr>
<td>03</td>
</tr>
<tr>
<td>04</td>
</tr>
<tr>
<td>05</td>
</tr>
<tr>
<td>06</td>
</tr>
<tr>
<td>07</td>
</tr>
<tr>
<td>08</td>
</tr>
<tr>
<td>09</td>
</tr>
<tr>
<td>10</td>
</tr>
<tr>
<td>11</td>
</tr>
<tr>
<td>12</td>
</tr>
<tr>
<td>13</td>
</tr>
<tr>
<td>14</td>
</tr>
<tr>
<td>15</td>
</tr>
<tr>
<td>16</td>
</tr>
</tbody>
</table>
MAKING SOUNDS

Once installed and activated, you can load Garritan Harps into the ARIA Player. Garritan Harps includes an extensive array of orchestral instruments, playing techniques, and playback effects. You can play these instruments:

1. By using the virtual on-screen keyboard in the ARIA Player,
2. By connecting a MIDI-compatible keyboard to your computer,
3. As a plug-in in your sequencer, or
4. In a supported notation program (such as Finale®).

1. USING THE VIRTUAL ON-SCREEN KEYBOARD

You can use the virtual keyboard at the bottom of the ARIA Player to play and audition instruments. The virtual keyboard displays the range of notes that can be played for the instrument patch that is loaded (indicated by the white notes). Keys that are being played will be highlighted in real time.

To play the virtual music keyboard, click the notes on the keyboard with your mouse. Clicking a note towards the bottom of the key plays the note with greater key velocity (like pressing a key harder), and clicking a note towards the top of the key plays the note with less key velocity (like pressing a key more softly).

2. USING A MIDI KEYBOARD WITH YOUR COMPUTER (STANDALONE ‘LIVE’ PLAY)

Garritan Harps can be launched by itself and played live via MIDI keyboard or other MIDI controllers. The standalone version of Garritan Harps effectively makes your computer, audio hardware, and MIDI keyboard into a virtual instrument that can be played independently of other programs. This mode is ideal for practicing, silent play, and live playing. The limitation is that you can usually play only one instrument at a time. Unlike using it as a plug-in within a sequencer, your
recording ability is limited and you cannot edit your performance (though you can use various audio software programs for this).

To launch Garritan Harps as a standalone program, double-click on the ARIA Player icon on your desktop or launch it from your Applications folder (Mac) or Start menu (Windows).

If your keyboard is a USB MIDI keyboard, simply connect the music keyboard to your computer using a USB cable. If your keyboard is a standard MIDI keyboard, connect the keyboard to your MIDI interface using standard MIDI cables, then connect the interface to your computer. Click **Tools > Preferences** to open the ARIA Preferences window. Your MIDI control device should appear in the MIDI Input Devices menu. Make sure that your device has a checkmark next to it.

**Play MIDI Files and Record**

The standalone ARIA program also features a MIDI File Player and audio recording system located on the bottom of the screen. With these controls you can load existing MIDI files into the ARIA Player to play back, and you can also record yourself playing live.

**NOTE:**

Be sure to refer to the manual that came with the keyboard and install the most recent keyboard drivers. For more information about using the ARIA Player, please refer to the ARIA User's Manual.

3. USING GARRITAN HARPS AS A PLUG-IN FOR SEQUENCERS AND DAWs

When used as a plug-in, Garritan Harps is not a standalone program but rather a virtual instrument module that can integrate seamlessly with many popular music software programs (assuming that the program supports such virtual instrument plug-ins). These are called “plug-ins” because they are modular software programs that run inside a “host” music program, such as a sequencer or digital audio workstation (DAW).

MIDI sequencing is similar to old player pianos that used mechanical techniques to reproduce performance. MIDI sequencers use digital data to record and reproduce performances. A major advantage to using a sequencer is that all
settings are saved together with the song files and are totally retained and recalled upon reload.

Garritan Harps supports VST, Audio Units, and RTAS plug-in formats. Each music software program has its own approach to handling virtual instrument plug-ins. Each has its own installation method and means of loading and accessing plug-ins. It is important to make sure that you refer to the instructions in your music software application's manual regarding the loading and operation of virtual instrument plug-ins.

**Regarding VST Plug-ins:**

At installation you will be prompted for the vstplugins folder directory. The installer will attempt to locate an existing vstplugins folder, or you can specify your own. You may need to re-scan the folders to have ARIA Player VST appear in the list of software instruments.

**Regarding AU (Audio Units—Mac Only):**

The ARIA Player will install into the default Mac OS X AU plug-ins folder, after which it will be readily available to your Mac music software.

**Regarding RTAS (Pro Tools systems only):**

The ARIA Player will automatically install the RTAS plug-in to its proper location to work with Pro Tools.

**SEE ALSO:**

For more information about using the ARIA Player as a plug-in, please refer to the ARIA User’s Manual.
4. USING GARRITAN HARPS IN NOTATION PROGRAMS

Notation is a fundamental part of music creation. Notation programs such as Finale allow you to easily create and print sheet music and play back your score with your computer. Garritan has a long history of pioneering the use of notation software programs with samples.

Garritan Harps can be used directly from within Finale (or other notation programs that are capable of hosting virtual instrument plug-ins). Garritan Harps supports VST and Audio Units plug-in formats.

Scoring in a notation program can be very mechanical and often lacks the feeling, phrasing, and nuance of music that is performed live. Features like Human Playback™ within Finale provide an advanced set of algorithms to enhance and “humanize” the playback of notation files. Garritan Harps has been optimized for use with Finale’s Human Playback.

**SEE ALSO:**
For more information about using Garritan Harps with notation, please refer to the instructions in your notation program’s manual regarding the loading and operation of virtual instrument plug-ins. Some notation programs may not support software virtual instrument plug-ins.
CONTROLS

VELOCITY (CC#12)
This control sets the current velocity amplitude tracking depth. Higher values will increase the amount of depth that the current amplitude envelopes have on the triggered notes. With a higher depth setting lower velocities will be naturally softer in amplitude, and higher velocities will have reached the maximum amplitude values. Lower velocity settings will result in all velocity input having close to the sample amplitude regardless of input velocity values.

RELEASE (CC#72)
Sustain pedal can be too long at times. This control affects normal release mode to allow tailored sustains throughout larger sequences where muddiness can occur.

PICK NOISE (CC#13)
This control sets the depth/amount of pick noise to be added. Currently picked noise layers only exist on Picked and Pres de la Table keyswitches. This control will not have any effect on articulations besides Picked and Pres de le Table throughout the library.
**SOFT (CC#74)**
Use this control to soften the character of your harp. It works well as a controllable MIDI CC, so that the harp can take on a brighter and darker character throughout the performance and movement of a piece.

**AGGRESSIVE (CC#81)**
Use this control to add more forcefulness and ‘grit’ to the attack of the harps. It utilizes the ARIA Player’s saturation effect to alter the attack transients.

**LIVE MODE (CC#99, “VAR”)**
This controls the new variation programming which is premiering in Garritan Harps, providing a more realistic ‘humanized’ performance. For producers and composers who want their compositions to sound identical in every performance, switch Live Mode off. It is important to note that this programming has not been included within the Pedal Mode nor the Gliss patches yet.

**PEDAL MODE (CC#29)**
This toggle switch enables the Pedal Mode, allowing the Pedal Configuration slider controls to be used. The Pedal Mode is a modern implementation for emulating the foot pedals of an orchestral harp. This is how you can achieve playable glissandi without the need for MIDI packets or other complicated setups.

The Pedal Mode sliders represent the seven pedals on the harp. Our implementation also offers double sharps and double flats, which are not possible on a real harp, yet offer even more advantage for producers looking for the easiest way to program and play custom harp glissandi. Each pedal has its own MIDI CC number as follows:

<table>
<thead>
<tr>
<th>PEDAL</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIDI CC#</td>
<td>39</td>
<td>40</td>
<td>41</td>
<td>42</td>
<td>43</td>
<td>44</td>
<td>45</td>
</tr>
</tbody>
</table>
The slider for each pedal responds to the values in the following table:

<table>
<thead>
<tr>
<th>SLIDER POSITION VALUES</th>
<th>Double-flat</th>
<th>Flat</th>
<th>Natural</th>
<th>Sharp</th>
<th>Double-sharp</th>
</tr>
</thead>
<tbody>
<tr>
<td>0–25</td>
<td>26–51</td>
<td>52–76</td>
<td>77–101</td>
<td>102–127</td>
<td></td>
</tr>
</tbody>
</table>

**STEREO STAGE CONTROL**

When Stereo Stage is turned off, instruments can be panned from left to right in the usual way, positioning them left to right by relative left/right volume intensity only. When Stereo Stage is turned on, it simulates the arrival times from the position of the instrumental sound source to a pair of virtual stereo microphones, plus the first reflections from side walls, rear walls, and the ceiling. This can create a more three-dimensional image for positioning instruments on the stage, both left to right and front to back. There are two Stereo Stage controls available on the Controls page of the ARIA player.

1. **On/Off button.** This toggle switch activates and disables Stereo Stage, lighting when activated. This switch can also be controlled using CC#103.
2. **Depth.** This sets the position of the instrument front to back on the stereo stage. Small percentage numbers place instruments closer to the microphones; larger percentages place instruments farther back on the stage, with 100% being near the back wall of the stage. The Depth parameter can also be controlled with CC#36.

When Stereo Stage is activated, the panning knobs in the mixer section of ARIA still control the left to right positioning.
Controlling timbre/EQ enables you to produce a clearer sound. When many instruments are added and played at once, the sound can become muddy. Judicious mixing and EQ can reduce sonic clutter so that combinations have better clarity and transparency, creating breathing room for the voices, so parts can be heard distinctly and clearly. In addition, the EQ controls can extend tonal range and allow better matching of sounds across the various harp patches.

The Precision EQ is a three-band equalizer, with each band having a separate gain knob (−24dB to +24 dB). The “Low” controls the filter’s gain for the bottom of the spectrum, the “Mid” controls the midrange frequencies, and the “High” controls the top end of the frequency spectrum. You can adjust these by placing your cursor over the desired knob, left clicking/holding, and moving the mouse up and down. Release the mouse button at the desired number.
## MIDI CONTROLLER QUICK REFERENCE

<table>
<thead>
<tr>
<th>Manual Controls</th>
<th>MIDI CC#</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume</td>
<td>7</td>
<td>Controls the overall presence of the loaded instrument in the mix. The instrument fader is located on the Mixer window.</td>
</tr>
<tr>
<td>Pan</td>
<td>10</td>
<td>Controls the panning of the loaded instrument. The pan knob is located on the Mixer window.</td>
</tr>
<tr>
<td>Velocity</td>
<td>12</td>
<td>Controls the “touch” of plucks to allow for more or less intensity by setting the width of the key velocity range. Higher values allow for greater variation in key velocity.</td>
</tr>
<tr>
<td>Pick Noise</td>
<td>13</td>
<td>Controls the amount of finger pluck sound. Pick noise layers only exist on Picked and Pres de la Table keyswitches.</td>
</tr>
<tr>
<td>Pedal Mode</td>
<td>29</td>
<td>Turns pedal mode on or off, emulating the foot pedals of the harp. Turning this control on allows the pedal slider controls (CC#39–45) to be used. Values 0–63 are off, 64–127 are on.</td>
</tr>
<tr>
<td>Pedals</td>
<td>39–45</td>
<td>For use with Pedal Mode (C through B). Set to 0–25 for double-flat; 26–51 for flat; 52–76 for natural (default); 77–101 for sharp; and 102–127 for double-sharp.</td>
</tr>
<tr>
<td>Release</td>
<td>72</td>
<td>Controls the amount of time a note is sustained/decays. Higher values increase length of decay.</td>
</tr>
<tr>
<td>Soft</td>
<td>74</td>
<td>Controls overall brightness of the sound. Higher values soften the character of the sound.</td>
</tr>
<tr>
<td>Aggressive</td>
<td>81</td>
<td>Controls overall aggressiveness of the sound. Higher values make the tone more aggressive.</td>
</tr>
<tr>
<td>Live Mode (“Var”)</td>
<td>99</td>
<td>Controls the amount of variation of tuning and volume between notes for a more “organic” sound. For no variation in sound, set this controller to 0.</td>
</tr>
<tr>
<td>Stereo Stage (“MIC Config”)</td>
<td>103</td>
<td>Turns stereo stage on or off. Values 0–63 are off, 64–127 are on.</td>
</tr>
<tr>
<td>Stereo Stage Depth</td>
<td>36</td>
<td>Controls the position of the instrument front to back on the stereo stage. Higher values place instruments farther back on the stage, with 100% being near the back wall of the stage; lower values place instruments closer to the microphones.</td>
</tr>
</tbody>
</table>
EFFECTS

REVERBERATION

Reverberation describes the phenomenon that occurs when a sound is made in an ambient space and is reflected or absorbed by the surfaces in that space. Reverb is perhaps the most widely-used audio effect, since it emulates the sound that’s heard literally everywhere around us. The ARIA Player includes two types of reverb: Ambience (algorithmic reverb) and Convolution (sampled reverb).

AMBIENCE REVERB

The ARIA Player’s Ambience reverb effect rivals the quality of the best commercial reverbs. Just as softsynth plug-ins represent virtual instruments designed to simulate musical instruments, Ambience allows you to simulate the reverberation of a cathedral, concert hall, and many other spaces.

Ambience is turned ON by default; to deactivate it, you must click the ON/OFF button located on the Effects window in the ARIA Player interface. It may not be necessary to use Ambience Reverb if you have your own separate reverb or convolution program.

NOTE:

To control the amount of reverb for each instrument, use the Send knobs in the Mixer window. The Send knob controls the amount of signal sent to the Ambience Reverb for each corresponding channel.

Ambience has a number of performing space presets to choose from. These presets have been custom-made and it is recommended that you begin with these presets. Presets include Ballroom 1 & 2, Cathedral, Church, Concert Hall 1 & 2, Jazz Club 1 & 2, Parlor, Piano Hall 1 & 2, and Recital Hall 1 & 2. You can also edit these presets or experiment with the various settings to customize the acoustical environment as needed.
There are nine main controls in the Ambience control panel. The most important parameters are Decay (the time for the reverb to fade away), Size (the size of the room), and Predelay (timing of first reflection). Below is a fuller description of the controls in Ambience:

- **DECAY** — This controls the time it takes for the reverb reflections to fade away into silence.
- **DIFFUSION** — Diffusion is the reflecting surface's ability to spread the reverb out. This control has a subtle effect on the sound and is especially noticeable with small room sizes.
- **SIZE** — This controls the size of the room. Note that long reverb time (decay) and small room size do not mix well. For natural sounds, the room size should correspond with the length of the reverb time.
- **PREDELAY** — This controls the amount of time between the direct sound and the first of the reverb reflections. It is predelay that defines our perception of the size of the room.
- **WIDTH** — This controls the stereo spread from mono (0%) all the way to a wide stereo (100%). It is recommended that the width be set close to 100%.
- **QUALITY** — This controls the render quality of the reverb effect. High quality equates to high CPU usage. If there is too much CPU demand on your machine while running ARIA, try turning down the quality. You can also make fun effects if you set this control very low (try it!).
- **EQUALIZER** — These four knobs provide a two-band EQ to control the overall timbre of the reverb. They can be useful for cutting away bass that can otherwise make the reverb sound muddy. They can also help to simulate the roll-off in response at high frequencies that is characteristic of most concert halls.
- **DAMPING** — This controls how the character of the reverb develops over time as it decays. Similar to the 2-band Equalizer, use this to control the decay time of bass and treble independently.
- **LEVEL** — This controls the amount of the processed reverberant sound.

**NOTE:**

It is important to bypass the on-board reverb of the ARIA Player when using a separate reverb or convolution effect in your host program. Failing to bypass the Ambience reverb will compound the reverb effect and the resultant sound will be very muddy.
Convolution Reverb

ARIA also includes an ultra-optimized convolution engine for high-quality sampled reverb which offers zero-latency processing with low CPU overhead. Just as the sounds of this library contain sampled musical instruments, the Convolution reverb was created by sampling the reverb in an actual acoustic space, such as a concert hall or cathedral, that one wouldn’t normally have an opportunity to record in. Because of this, Convolution faithfully reproduces the natural-sounding reverberations that have been captured from these real physical spaces, down to their minutest details and nuances. Rather than providing a simulation synthesized by an algorithmic reverb (Ambience), the samples of a convolution reverb effect are well known for their realism.

An impulse response is the recording of the reverberation that is produced in an acoustic space when an impulse sound is played in that space. It represents a sonic signature of that sampled space.

For the individual harp patches, Convolution reverb is turned OFF by default and to activate it you must click the ON/OFF button located on the Effects window in the ARIA Player interface. For the Harps ensembles, Convolution is ON by default and Ambience Off.

NOTE:

To control the amount of reverb for each instrument, use the Send knobs in the Mixer window. The Send knob controls the amount of signal sent to the Convolution reverb for each corresponding channel.

It may not be necessary to use Convolution Reverb when using Ambience or vice versa. Additionally, there are some situations where you may want to use both Ambience and Convolution reverbs to exaggerate a certain space or element. There are two controls available for the Convolution reverb effect:

- **PREDELAY** — This control adjusts the length of the reverb tail, or how fast the reverb dies down.
- **LEVEL** — This control adjusts the level of room contribution.
The ARIA Player includes an impressive collection of 10 impulse responses, with an additional 7 impulse responses unique to the Garritan Harps library. Included are the glorious sounds of cathedrals, churches, well-known symphonic concert halls, and other stunning acoustic spaces.

- **Chapel** — Sampled reverb from a famous chapel in Cambridge, Massachusetts, USA.
- **Film Score Space** — Sampled reverb from a well-known film scoring space in Seattle, Washington, USA that has been used for many popular movies.
- **Large European Cathedral** — Sampled reverb from a large cathedral in the Czech Republic.
- **Large Symphonic Concert Hall** — Sampled reverb from a well-known large concert hall located in Seattle.
- **Medium Piano Concert Hall** — Sampled reverb from one of the best piano halls located in upstate New York.
- **Modern Symphonic Concert Hall** — Sampled reverb from a modern state-of-the-art concert hall located in Vancouver, British Columbia, Canada.
- **Small Chamber Space** — Sampled reverb from a small chamber recording space in Boston, Massachusetts, USA.
- **Small Orchestra Hall** — Sampled reverb from a small concert hall located in Brno, Czech Republic.
- **Traditional Symphonic Concert Hall** — Sampled reverb from the Dvorak Hall (the Rudolphium), a large traditional concert hall in Prague, Czech Republic.
- **Underground Cave** — Sampled reverb from an underground cave located in the Czech Republic.

**NOTE:**
You can use both Ambience reverb and Convolution to shape your room sound. Both Ambience reverb and Convolution must be set to ON to use both effects simultaneously. Also, it is important to bypass the on-board reverb of the ARIA Player when using a separate reverb or convolution effect in your host program. Failing to bypass the Ambience reverb will compound the reverb effect and the resultant sound will be very muddy.
SCALA FILES FOR HISTORIC TUNINGS

The ARIA Player includes a control on the Settings window that provides a variety of tunings that can be imported and used with Garritan Harps. This can be useful in playing historic pieces using a tuning appropriate to the era. Differing temperaments can add extra color and warmth to the sound. Scala files can also provide detuning for more authentic sounds.

The Scala file import feature enables the use of thousands of other tunings that can be found on the internet. The ARIA Player includes 16 built-in tunings; by default, the equal temperament tuning is loaded.

To choose a different tuning, click the **Import** button. The dialog shown below appears, displaying the 16 installed tunings and any others placed in the Scales folder. Choose one of the Scala files and click **Open** to apply the tuning.

The **Scala Center** option allows you to select the tonic note of your scale. By default, this is set to C5. The **Tuning** option allows you to select from eleven base frequencies for the note A4. By default, this is set to A4 = 440 Hz.
ENSEMBLE PRESETS
LOAD MULTIPLE PATCHES EASILY

The Garritan Harps installation includes a folder/directory called “Ensembles” that contains a collection of useful, pre-configured ensembles for your convenience. Each ensemble preset loads a selection of instruments along with pan, level, and other settings. The Ensembles folder can be found in the Garritan installation folder. By default, this folder is located at /Garritan/ARIA Player/Presets/com.Plogue.Aria/Garritan Harps.

### LIST OF ENSEMBLE PRESETS: COMBOS

<table>
<thead>
<tr>
<th>Ensemble Name:</th>
<th>Instruments Included:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster Harps</td>
<td>Salvi Gliss Harp 1 Sustain, Salvi Gliss Harp 2 Sustain, Lyon &amp; Healy Gliss Harp 1 Sustain.</td>
</tr>
<tr>
<td>In the Clouds</td>
<td>Salvi Harp 1 Sustain, Venus Harp 2 Picked</td>
</tr>
<tr>
<td>Percussive Space Harps</td>
<td>Salvi Harp 2 Picked, Venus Harp 2 Picked</td>
</tr>
<tr>
<td>Ready for the Concert</td>
<td>Lyon &amp; Healy Harp 1 KS</td>
</tr>
<tr>
<td>Super Wide and Soft</td>
<td>Lyon &amp; Healy Harp 1 Sustain, Venus Harp 1 Sustain</td>
</tr>
<tr>
<td>Super Wide</td>
<td>Lyon &amp; Healy Harp 1 Sustain, Venus Harp 2 Sustain</td>
</tr>
<tr>
<td>This Isn't a Harp</td>
<td>Salvi Harp 1 Damped, Salvi Harp 1 Harmonics</td>
</tr>
<tr>
<td>Wall of Harps</td>
<td>Lyon &amp; Healy Harp 1 Sustain, Venus Harp 1 Sustain, Salvi Harp 1 Sustain, Salvi Harp 2 Sustain</td>
</tr>
</tbody>
</table>

Although not technically ensembles, there is also a wide variety of preset glisses provided so that you do not have to individually set each pedal. These presets are organized by the tonic note of the scale or chord. In addition, there are six special scale presets (Blues, Enigmatic, Hungarian Major, Persian, Romanian, Unrealistic) and four whole tone scales. All of these presets are located under the Glisses category.
LOADING ENSEMBLE PRESET FILES

In standalone mode there are two ways to load ensemble preset files. First, you can load them from the File menu (File > Load). Second, you can use the drag and drop method by opening the “Ensembles” folder/directory,dragging the desired ensemble preset onto the ARIA interface, and releasing the mouse button. The instruments and their configurations will load automatically. When ARIA is used as a plug-in from within a host program, the drag and drop method is recommended for loading ensemble files.

NOTE:

Note that in Standalone mode you can create customized ensemble files. Just load the stops you want and adjust their settings to your liking. Choose File > Save As to save the preset.
DIRECTORY OF HARP PATCHES
# GARritan Harps Patch List

## Salvi Pedal Harp 1 Patch List

<table>
<thead>
<tr>
<th>Patch Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Salvi Harp 1 KS</td>
<td>The ‘master’ patch which contains all of the articulations. The articulations can be accessed by their representative keyswitches.</td>
</tr>
<tr>
<td>Salvi Harp 1 Sustain</td>
<td>The normal (undamped) pluck articulation. This is the most common harp articulation.</td>
</tr>
<tr>
<td>Salvi Harp 1 Picked</td>
<td>A normal pluck articulation that additionally triggers the pick noise set by the controller knob on the Controls view.</td>
</tr>
<tr>
<td>Salvi Harp 1 Harmonics</td>
<td>String harmonics, sounding an octave higher than the normal string.</td>
</tr>
<tr>
<td>Salvi Harp 1 Pres de la Table</td>
<td>The articulation patch for the pres de la table technique (near the soundboard).</td>
</tr>
<tr>
<td>Salvi Harp 1 Damped</td>
<td>Also known as muffling, the damping articulation features a specialized sample set for a natural-sounding release. This has a character very much like a soft harmonic.</td>
</tr>
</tbody>
</table>

## Salvi Pedal Harp 2 Patch List

<table>
<thead>
<tr>
<th>Patch Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Salvi Harp 2 KS</td>
<td>The ‘master’ patch which contains all of the articulations. The articulations can be accessed by their representative keyswitches.</td>
</tr>
<tr>
<td>Salvi Harp 2 Sustain</td>
<td>The normal (undamped) pluck articulation. This is the most common harp articulation.</td>
</tr>
<tr>
<td>Salvi Harp 2 Picked</td>
<td>A normal pluck articulation that additionally triggers the pick noise set by the controller knob on the Controls view.</td>
</tr>
<tr>
<td>Salvi Harp 2 Harmonics</td>
<td>String harmonics, sounding an octave higher than the normal string.</td>
</tr>
<tr>
<td>Salvi Harp 2 Pres de la Table</td>
<td>The articulation patch for the pres de la table technique (near the soundboard).</td>
</tr>
<tr>
<td>Salvi Harp 2 Damped</td>
<td>Also known as muffling, the damping articulation features a specialized sample set for a natural-sounding release. This has a character very much like a soft harmonic.</td>
</tr>
</tbody>
</table>
## VENUS CONCERT GRAND 1 PATCH LIST

<table>
<thead>
<tr>
<th>Patch Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Venus Harp 1 KS</td>
<td>The ‘master’ patch which contains all of the articulations. The articulations can be accessed by their representative keyswitches.</td>
</tr>
<tr>
<td>Venus Harp 1 Sustain</td>
<td>The normal (undamped) pluck articulation. This is the most common harp articulation.</td>
</tr>
<tr>
<td>Venus Harp 1 Picked</td>
<td>A normal pluck articulation that additionally triggers the pick noise set by the controller knob on the Controls view.</td>
</tr>
<tr>
<td>Venus Harp 1 Harmonics</td>
<td>String harmonics, sounding an octave higher than the normal string.</td>
</tr>
<tr>
<td>Venus Harp 1 Pres de la Table</td>
<td>The articulation patch for the pres de la table technique (near the soundboard).</td>
</tr>
<tr>
<td>Venus Harp 1 Damped</td>
<td>Also known as muffling, the damping articulation features a specialized sample set for a natural-sounding release. This has a character very much like a soft harmonic.</td>
</tr>
</tbody>
</table>

## VENUS CONCERT GRAND 2 PATCH LIST

<table>
<thead>
<tr>
<th>Patch Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Venus Harp 2 KS</td>
<td>The ‘master’ patch which contains all of the articulations. The articulations can be accessed by their representative keyswitches.</td>
</tr>
<tr>
<td>Venus Harp 2 Sustain</td>
<td>The normal (undamped) pluck articulation. This is the most common harp articulation.</td>
</tr>
<tr>
<td>Venus Harp 2 Picked</td>
<td>A normal pluck articulation that additionally triggers the pick noise set by the controller knob on the Controls view.</td>
</tr>
<tr>
<td>Venus Harp 2 Harmonics</td>
<td>String harmonics, sounding an octave higher than the normal string.</td>
</tr>
<tr>
<td>Venus Harp 2 Pres de la Table</td>
<td>The articulation patch for the pres de la table technique (near the soundboard).</td>
</tr>
<tr>
<td>Venus Harp 2 Damped</td>
<td>Also known as muffling, the damping articulation features a specialized sample set for a natural-sounding release. This has a character very much like a soft harmonic.</td>
</tr>
</tbody>
</table>
### LYON & HEALY HARP PATCH LIST

<table>
<thead>
<tr>
<th>Patch Name:</th>
<th>Description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lyon &amp; Healy Harp 1 KS</td>
<td>The ‘master’ patch which contains both of the articulations. The articulations can be accessed by their representative keyswitches.</td>
</tr>
<tr>
<td>Lyon &amp; Healy Harp 1 Sustain</td>
<td>The normal (undamped) pluck articulation. This is the most common harp articulation.</td>
</tr>
<tr>
<td>Lyon &amp; Healy Harp 1 Picked</td>
<td>A normal pluck articulation that additionally triggers the pick noise set by the controller knob on the Controls view.</td>
</tr>
<tr>
<td>Lyon &amp; Healy Harp 1 Harmonics</td>
<td>String harmonics, sounding an octave higher than the normal string.</td>
</tr>
</tbody>
</table>

### GLISS HARPS PATCH LIST

<table>
<thead>
<tr>
<th>Patch Name:</th>
<th>Description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Salvi Gliss Harp 1 Sustain</td>
<td>The normal (undamped) pluck articulation for the Salvi Pedal Harp 1.</td>
</tr>
<tr>
<td>Salvi Gliss Harp 1 Picked</td>
<td>A normal pluck articulation for the Salvi Pedal Harp 1 that additionally triggers the pick noise set by the controller knob on the Controls view.</td>
</tr>
<tr>
<td>Salvi Gliss Harp 1 Pres de la Table</td>
<td>The articulation patch for the pres de la table technique (near the soundboard) for the Salvi Pedal Harp 1.</td>
</tr>
<tr>
<td>Salvi Gliss Harp 2 Sustain</td>
<td>The normal (undamped) pluck articulation for the Salvi Pedal Harp 2.</td>
</tr>
<tr>
<td>Salvi Gliss Harp 2 Pres de la Table</td>
<td>The articulation patch for the pres de la table technique (near the soundboard) for the Salvi Pedal Harp 2.</td>
</tr>
<tr>
<td>Venus Gliss Harp 1 Sustain</td>
<td>The normal (undamped) pluck articulation for the Venus Concert Grand 1.</td>
</tr>
<tr>
<td>Venus Gliss Harp 2 Sustain</td>
<td>The normal (undamped) pluck articulation for the Venus Concert Grand 2.</td>
</tr>
<tr>
<td>Lyon &amp; Healy Gliss Harp 1 Sustain</td>
<td>The normal (undamped) pluck articulation for the Lyon &amp; Healy Harp.</td>
</tr>
</tbody>
</table>
GETTING STARTED

You can use any of the Garritan libraries on their own, for live play with a MIDI keyboard or other MIDI controller, or as a plug-in with a notation program or DAW. All of the Garritan libraries are accessed through the ARIA Player and can be used interchangeably with each other. The first step to bringing your music to life with the Garritan sounds is to learn to use the ARIA Player. This will give you control over basic functions such as mixing and panning, as well as instrument-specific performance techniques such as bowings, articulations, vibrato, special effects and much more.

The ARIA Player manual will guide you through the basics of the ARIA interface and controls. For more information about each library and the instrument-specific controls, refer to the library-specific guides. You will find all of these manuals in the library installation folder on your computer.

GETTING SUPPORT

If you are experiencing a technical problem with the ARIA Player or one of the Garritan libraries, visit our support page at www.garritan.com/support. There, you can search our Knowledge Base for answers to common questions, visit the Garritan forum for suggestions from users of Garritan software, or submit a case to our support team.

SEE ALSO:

Regarding third-party customer service: if you are using a Garritan library as a plug-in in a third-party host program, please contact the program manufacturer for support.

UPDATING YOUR SOFTWARE

Updates are released regularly to fix known problems and improve the software. Be sure to check www.garritan.com/support for any possible updates that have occurred since the time your software was manufactured. The ARIA Player is frequently updated and a more recent version may be available.
ACKNOWLEDGMENTS

Producing Garritan Harps would not have been possible without the combined help, talent, and support of many extraordinary people. I am grateful to those who have been a part of this project.

Many thanks to all the harpists who endured sore fingers and long sessions playing endless scales. Thanks to Heidi Soons, who played the Lyon & Healy Style 23 concert grand harp. We would also like to thank Lane Gibson, who was the engineer for the session. Thanks also to McGill University and especially to Joel Wapnick and Frank Opolko for the recording of one of the harps in Montreal. Thanks to my harp teachers Atahualpa Poalasin and Daphne Hellman.

I especially wish to thank Chad Beckwith for the exceptional programming of this harp library. Thanks also to Robert Davis, who came up with some of the innovative pedaling programming. Thanks to Tom Hopkins, who did the initial GigaHarp programming, and Jeannot Welter for sample editing.

Thanks to Jonathan Tschiggfrie and Erin Vork for their work on the manual. Many thanks to Scott Menk for his extraordinary artwork. And thanks again to Robert Davis for his thorough testing and harp demos.

I wish to thank our beta team who provided valuable input: Fred Flowerday, Jim Ortner, Justin Phillips, Prof. Jim Williams, Tony Monaghan, Dan Kury, Peter Jones, Robert Davis, Bill DeWitt, Jack Cannon, Robert Tewes, Peter O’Regan, Petr Pololáník, Jeremy Soule, and Randy Bowser; many thanks to David Sosnowski for harping on me.

The custom-made ARIA sample engine for Garritan Harps was developed by Plogue Art et Technologie, Inc. David Viens and his team took up the task brilliantly and brought forth the technologically stunning ARIA sample engine used for this project. A special thanks to Max Deland and Chris Anderson for helping to manage this project.

Many thanks and bravos to Karen VanDerBosch (COO/CFO and acting CEO), Beth Sorensen (VP Emerging Music Technology), Chris Anderson (Project Manager), Justin Phillips (Senior Product Manager), Carol Spenillo (Marketing Manager), Jonathan Tschiggfrie (Product Documentation), Fred Flowerday (QA), Erin Vork (Product Specialist and Documentation), Mark Adler (documentation support), Barry Brown (SVP Marketing and Product Management), Jim Bruce (Customer Support and Facilities Manager), Paul Carlson (CTO), Ryan Demlow (support
file development), Hailey Dillon (Marketing Director), Chris Fischer (Inventory Analyst), Allen Fisher (Installers), Tim Fitzpatrick (Business Systems Manager), Yvonne Grover (QA Manager), Kyle Imbertson (QA and support file development), Scott Menk (Art Director), Jeff Nordquist (Notation Engineering Manager), David Olson (Business Systems), Joy Parker (Business Systems), Gary Pederson (Installers), Lori Schug (Corporate Controller), Chris Young (QA), and the rest of the MakeMusic team for all their help and invaluable assistance.

And to Marianne, who continually inspires me and tugs on my heart strings.
THE GARRITAN COMMUNITY

LEARN, SHARE MUSIC, AND STAY UP TO DATE

We invite you to join the Garritan Community!

Owning Garritan Harps gives you much more than just a product. One of the most valuable benefits is membership in the Garritan community of musicians.

The Garritan Forum is where Garritan users from around the world come to discuss everything related to soundware and music. It’s the perfect way to find the latest news and announcements, ask questions, and share your music created with Garritan libraries. If you want to browse, share your music, share your thoughts about the sounds, impart knowledge, listen to demos, learn, and interact with other users—this is the place! You can also communicate privately with other musicians, respond to polls, participate in real-time chats, read how-to tutorials, and get support and help from others. There is a wealth of information among the tens of thousands of posts in the forum and a convenient search feature to find exactly what you are looking for.

The Garritan forum can be accessed at: www.garritan.com/forum.

You do not have to register to browse posts, but before you can post, you need to sign up. Registration is fast, simple, and absolutely free, so please join our community today! In addition to the official Garritan Forum, there are other independent Garritan communities where you can find valuable information and interact with other users. I urge you to contribute and be a part of the Garritan Community, where you will find an indispensable resource for musicians.
ADDITIONAL GARRITAN SOUND LIBRARIES

GET MORE SOUNDS INSTANTLY AND EASILY

Download sounds quickly and easily to expand your musical palette. Simply go to the Settings window in the ARIA Player and click on the “Get More Sounds” button. You'll be taken to the Garritan Products Store, where you can purchase additional downloadable sound libraries.

For information on all current Garritan libraries and upcoming products, visit our website at www.garritan.com.

MORE PRODUCTS FROM GARRITAN

- Personal Orchestra
- Jazz & Big Band
- Concert & Marching Band
- World Instruments
- Instant Orchestra
- Classic Pipe Organs

![Images of Garritan products]